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e² studio 6.1.0 
Release Note 
Introduction 
This document outlines the device support, new features added in 6.1.0, fixed issues and open issues in e² studio 6.1.0. 
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1. Product Information 
1.1 Supported Operating Systems 

These operating systems are officially supported by e2 studio: 

• Windows 7 32-bit 

• Windows 7 64-bit 

• Windows 8.1 32-bit 

• Windows 8.1 64-bit 

• Windows 10 32-bit 

• Windows 10 64-bit 

 

1.2 Supported Toolchains 
The following toolchains are supported in e² studio 6.1.0. 

 
   Renesas Launchpad  

GCC (*2) 
Renesas GCC/  
KPIT GCC (*3) 

IAR (*4) Green Hills (*5) 

D
ev

ic
e 

Fa
m

ily
 

RL78 Yes (CC-RL) No Yes Yes No 

RX Yes (CC-RX) No Yes Yes No 

RH850 No No No Yes Yes 

RZ/ARM No No (*1) Yes Yes No 

Synergy/ARM No Yes No Yes No 

 
Note:  
*1: Converter is now available to convert RZ ARM-none GCC toolchain to use Launchpad GCC. 

*2: The GNU Launchpad toolchain is distributed via the www.launchpad.net website and is available 
here: https://launchpad.net/gcc-arm-embedded.  

*3: Legacy KPIT GCC toolchains are now available from www.renesas-gcc.com. In addition, the latest RX 
and RL Renesas GCC toolchains are available from this website. 

*4: The IAR toolchain plugins are available via the “Help”->”IAR Embedded Workbench plugin manager” 
menu in e2 studio. These Eclipse plugins are provided by IAR and are not supported by Renesas.  

*5: The Green Hills toolchain plugins are available within the e² studio product. These plugins are provided 
by Green Hills and are not supported by Renesas.  

https://launchpad.net/gcc-arm-embedded
http://www.renesas-gcc.com/
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2. Device Support 
2.1 Project Generator Support 
Note: The Renesas SH device family is no longer supported in e2 studio. 

CPU Family Devices 
EC-1 EC-1 R9A06G043 

RH850 

C1H R7F701260, R7F701270,(Debug Support Only) 
C1M R7F701263, R7F701271,(Debug Support Only) 
E1L R7F701201, R7F701205,(Debug Support Only) 

E1M-S R7F701202, R7F701204,(Debug Support Only) 
- R7F701Z05, R7F701Z06, R7F701Z07,(Debug Support Only) 

F1H 

R7F701501, R7F701502, R7F701503, R7F701506, R7F701507, 
R7F701508, R7F701511, R7F701512, R7F701513,(Debug Support 
Only) 

F1H-GW 
R7F701521, R7F701522, R7F701524, R7F701525,(Debug Support 
Only) 

F1K 

R7F701542, R7F701543, R7F701546, R7F701547, R7F701557, 
R7F701560, R7F701561, R7F701562, R7F701563, R7F701566, 
R7F701567, R7F701577, R7F701580, R7F701581, R7F701582, 
R7F701583, R7F701586, R7F701587, R7F701597, R7F701602, 
R7F701603, R7F701610, R7F701611, R7F701612, R7F701613, 
R7F701620, R7F701621, R7F701622, R7F701623,(Debug Support 
Only) 

F1L 

R7F701002xAFP, R7F701003xAFP, R7F701006xAFP, 
R7F701007xAFP, R7F701008xAFP, R7F701009xAFP, 
R7F701010xAFP, R7F701011xAFP, R7F701012xAFP, 
R7F701013xAFP, R7F701014xAFP, R7F701015xAFP, 
R7F701016xAFP, R7F701017xAFP, R7F701018xAFP, 
R7F701019xAFP, R7F701020xAFP, R7F701021xAFP, 
R7F701022xAFP, R7F701023xAFP, R7F701024xAFP, 
R7F701025xAFP, R7F701026xAFP, R7F701027xAFP, 
R7F701028xAFP, R7F701029xAFP, R7F701030xAFP, 
R7F701032xAFP, R7F701033xAFP, R7F701034xAFP, R7F701040, 
R7F701041, R7F701042, R7F701043, R7F701044, R7F701045, 
R7F701046, R7F701047, R7F701048, R7F701049, R7F701050, 
R7F701051, R7F701052, R7F701053, R7F701054, R7F701055, 
R7F701056, R7F701057,(Debug Support Only) 

F1M 

R7F701544, R7F701545, R7F701548, R7F701549, R7F701552, 
R7F701553, R7F701564, R7F701565, R7F701568, R7F701569, 
R7F701572, R7F701573,(Debug Support Only) 

P1M 

R7F701304, R7F701305, R7F701310, R7F701311, R7F701312, 
R7F701313, R7F701314, R7F701315, R7F701318, R7F701319, 
R7F701320, R7F701321, R7F701322, R7F701323,(Debug Support 
Only) 

P1M-E 

R7F701375, R7F701376, R7F701377, R7F701378, R7F701379, 
R7F701380, R7F701381, R7F701382, R7F701383, R7F701384, 
R7F701385, R7F701386,(Debug Support Only) 

- 

R7F701060xAFP, R7F701062xAFP, R7F701064xAFP, 
R7F701065xAFP, R7F701067xAFP, R7F701069xAFP, 
R7F701071xAFP,(Debug Support Only) 
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RL78 

D1A 

R5F10CGB, R5F10CGC, R5F10CGD, R5F10CLD, R5F10CMD, 
R5F10CME, R5F10DGC, R5F10DGD, R5F10DGE, R5F10DLD, 
R5F10DLE, R5F10DMD, R5F10DME, R5F10DMF, R5F10DMG, 
R5F10DMJ, R5F10DPE, R5F10DPF, R5F10DPG, R5F10DPJ, 
R5F10DPK, R5F10DPL, R5F10DSJ, R5F10DSK, R5F10DSL, R5F10TPJ 

F12 

R5F10968, R5F1096A, R5F1096B, R5F1096C, R5F1096D, R5F1096E, 
R5F109AA, R5F109AB, R5F109AC, R5F109AD, R5F109AE, 
R5F109BA, R5F109BB, R5F109BC, R5F109BD, R5F109BE, 
R5F109GA, R5F109GB, R5F109GC, R5F109GD, R5F109GE, 
R5F109LA, R5F109LB, R5F109LC, R5F109LD, R5F109LE 

F13 

R5F10A6A, R5F10A6C, R5F10A6D, R5F10A6E, R5F10AAA, 
R5F10AAC, R5F10AAD, R5F10AAE, R5F10ABA, R5F10ABC, 
R5F10ABD, R5F10ABE, R5F10AGA, R5F10AGC, R5F10AGD, 
R5F10AGE, R5F10AGF, R5F10AGG, R5F10ALC, R5F10ALD, 
R5F10ALE, R5F10ALF, R5F10ALG, R5F10AME, R5F10AMF, 
R5F10AMG, R5F10BAC, R5F10BAD, R5F10BAE, R5F10BAF, 
R5F10BAG, R5F10BBC, R5F10BBD, R5F10BBE, R5F10BBF, 
R5F10BBG, R5F10BGC, R5F10BGD, R5F10BGE, R5F10BGF, 
R5F10BGG, R5F10BLC, R5F10BLD, R5F10BLE, R5F10BLF, R5F10BLG, 
R5F10BME, R5F10BMF, R5F10BMG 

F14 

R5F10PAD, R5F10PAE, R5F10PBD, R5F10PBE, R5F10PGD, 
R5F10PGE, R5F10PGF, R5F10PGG, R5F10PGH, R5F10PGJ, 
R5F10PLE, R5F10PLF, R5F10PLG, R5F10PLH, R5F10PLJ, R5F10PME, 
R5F10PMF, R5F10PMG, R5F10PMH, R5F10PMJ, R5F10PPE, 
R5F10PPF, R5F10PPG, R5F10PPH, R5F10PPJ 

F15 

R5F113GK, R5F113GL, R5F113LK, R5F113LL, R5F113MK, 
R5F113ML, R5F113PG, R5F113PH, R5F113PJ, R5F113PK, R5F113PL, 
R5F113TG, R5F113TH, R5F113TJ, R5F113TK, R5F113TL 

F1A R5F114GC, R5F114GD, R5F114GE, R5F114GF, R5F114GG 
G10 R5F10Y14, R5F10Y16, R5F10Y17, R5F10Y44, R5F10Y46, R5F10Y47 

G11 

R5F1056A, R5F1057A, R5F1058A 
 
R5F1051A, R5F1054A,(Debug Support Only) 

G12 

R5F10266, R5F10267, R5F10268, R5F10269, R5F1026A, R5F10277, 
R5F10278, R5F10279, R5F1027A, R5F102A7, R5F102A8, R5F102A9, 
R5F102AA, R5F10366, R5F10367, R5F10368, R5F10369, R5F1036A, 
R5F10377, R5F10378, R5F10379, R5F1037A, R5F103A7, R5F103A8, 
R5F103A9, R5F103AA 
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G13 

R5F1006A, R5F1006C, R5F1006D, R5F1006E, R5F1007A, R5F1007C, 
R5F1007D, R5F1007E, R5F1008A, R5F1008C, R5F1008D, R5F1008E, 
R5F100AA, R5F100AC, R5F100AD, R5F100AE, R5F100AF, 
R5F100AG, R5F100BA, R5F100BC, R5F100BD, R5F100BE, 
R5F100BF, R5F100BG, R5F100CA, R5F100CC, R5F100CD, R5F100CE, 
R5F100CF, R5F100CG, R5F100EA, R5F100EC, R5F100ED, R5F100EE, 
R5F100EF, R5F100EG, R5F100EH, R5F100FA, R5F100FC, R5F100FD, 
R5F100FE, R5F100FF, R5F100FG, R5F100FH, R5F100FJ, R5F100FK, 
R5F100FL, R5F100GA, R5F100GC, R5F100GD, R5F100GE, 
R5F100GF, R5F100GG, R5F100GH, R5F100GJ, R5F100GK, 
R5F100GL, R5F100JC, R5F100JD, R5F100JE, R5F100JF, R5F100JG, 
R5F100JH, R5F100JJ, R5F100JK, R5F100JL, R5F100LC, R5F100LD, 
R5F100LE, R5F100LF, R5F100LG, R5F100LH, R5F100LJ, R5F100LK, 
R5F100LL, R5F100MF, R5F100MG, R5F100MH, R5F100MJ, 
R5F100MK, R5F100ML, R5F100PF, R5F100PG, R5F100PH, 
R5F100PJ, R5F100PK, R5F100PL, R5F100SH, R5F100SJ, R5F100SK, 
R5F100SL, R5F1016A, R5F1016C, R5F1016D, R5F1016E, R5F1017A, 
R5F1017C, R5F1017D, R5F1017E, R5F1018A, R5F1018C, R5F1018D, 
R5F1018E, R5F101AA, R5F101AC, R5F101AD, R5F101AE, 
R5F101AF, R5F101AG, R5F101BA, R5F101BC, R5F101BD, 
R5F101BE, R5F101BF, R5F101BG, R5F101CA, R5F101CC, R5F101CD, 
R5F101CE, R5F101CF, R5F101CG, R5F101EA, R5F101EC, R5F101ED, 
R5F101EE, R5F101EF, R5F101EG, R5F101EH, R5F101FA, R5F101FC, 
R5F101FD, R5F101FE, R5F101FF, R5F101FG, R5F101FH, R5F101FJ, 
R5F101FK, R5F101FL, R5F101GA, R5F101GC, R5F101GD, 
R5F101GE, R5F101GF, R5F101GG, R5F101GH, R5F101GJ, 
R5F101GK, R5F101GL, R5F101JC, R5F101JD, R5F101JE, R5F101JF, 
R5F101JG, R5F101JH, R5F101JJ, R5F101JK, R5F101JL, R5F101LC, 
R5F101LD, R5F101LE, R5F101LF, R5F101LG, R5F101LH, R5F101LJ, 
R5F101LK, R5F101LL, R5F101MF, R5F101MG, R5F101MH, 
R5F101MJ, R5F101MK, R5F101ML, R5F101PF, R5F101PG, 
R5F101PH, R5F101PJ, R5F101PK, R5F101PL, R5F101SH, R5F101SJ, 
R5F101SK, R5F101SL 

G14 

R5F104AA, R5F104AC, R5F104AD, R5F104AE, R5F104AF, 
R5F104AG, R5F104BA, R5F104BC, R5F104BD, R5F104BE, 
R5F104BF, R5F104BG, R5F104CA, R5F104CC, R5F104CD, R5F104CE, 
R5F104CF, R5F104CG, R5F104EA, R5F104EC, R5F104ED, R5F104EE, 
R5F104EF, R5F104EG, R5F104EH, R5F104FA, R5F104FC, R5F104FD, 
R5F104FE, R5F104FF, R5F104FG, R5F104FH, R5F104FJ, R5F104GA, 
R5F104GC, R5F104GD, R5F104GE, R5F104GF, R5F104GG, 
R5F104GH, R5F104GJ, R5F104GK, R5F104GL, R5F104JC, R5F104JD, 
R5F104JE, R5F104JF, R5F104JG, R5F104JH, R5F104JJ, R5F104LC, 
R5F104LD, R5F104LE, R5F104LF, R5F104LG, R5F104LH, R5F104LJ, 
R5F104LK, R5F104LL, R5F104MF, R5F104MG, R5F104MH, 
R5F104MJ, R5F104MK, R5F104ML, R5F104PF, R5F104PG, 
R5F104PH, R5F104PJ, R5F104PK, R5F104PL 

G1A 

R5F10E8A, R5F10E8C, R5F10E8D, R5F10E8E, R5F10EBA, R5F10EBC, 
R5F10EBD, R5F10EBE, R5F10EGA, R5F10EGC, R5F10EGD, 
R5F10EGE, R5F10ELC, R5F10ELD, R5F10ELE 

G1C R5F10JBC, R5F10JGC, R5F10KBC, R5F10KGC 
G1D R5F11AGG, R5F11AGH, R5F11AGJ 
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G1E 
R5F10FLC, R5F10FLD, R5F10FLE, R5F10FMC, R5F10FMD, 
R5F10FME 

G1F 
R5F11B7C, R5F11B7E, R5F11BBC, R5F11BBE, R5F11BCC, R5F11BCE, 
R5F11BGC, R5F11BGE, R5F11BLC, R5F11BLE 

G1G R5F11EA8, R5F11EAA, R5F11EB8, R5F11EBA, R5F11EF8, R5F11EFA 
G1H R5F11FLJ, R5F11FLK, R5F11FLL 
I1A R5F1076C, R5F107AC, R5F107AE, R5F107DE 
I1B R5F10MME, R5F10MMG, R5F10MPE, R5F10MPG 

I1C 
R5F10NLE, R5F10NLG, R5F10NME, R5F10NMG, R5F10NMJ, 
R5F10NPG, R5F10NPJ 

I1D 
R5F11768, R5F1176A, R5F11778, R5F1177A, R5F117A8, R5F117AA, 
R5F117AC, R5F117BA, R5F117BC, R5F117GA, R5F117GC 

I1E R5F11CBC, R5F11CCC 

L12 

R5F10RB8, R5F10RBA, R5F10RBC, R5F10RF8, R5F10RFA, R5F10RFC, 
R5F10RG8, R5F10RGA, R5F10RGC, R5F10RJ8, R5F10RJA, R5F10RJC, 
R5F10RLA, R5F10RLC 

L13 

R5F10WLA, R5F10WLC, R5F10WLD, R5F10WLE, R5F10WLF, 
R5F10WLG, R5F10WMA, R5F10WMC, R5F10WMD, R5F10WME, 
R5F10WMF, R5F10WMG 

L1A 
R5F11MMD, R5F11MME, R5F11MMF, R5F11MPE, R5F11MPF, 
R5F11MPG 

L1C 

R5F110ME, R5F110MF, R5F110MG, R5F110MH, R5F110MJ, 
R5F110NE, R5F110NF, R5F110NG, R5F110NH, R5F110NJ, 
R5F110PE, R5F110PF, R5F110PG, R5F110PH, R5F110PJ, R5F111ME, 
R5F111MF, R5F111MG, R5F111MH, R5F111MJ, R5F111NE, 
R5F111NF, R5F111NG, R5F111NH, R5F111NJ, R5F111PE, 
R5F111PF, R5F111PG, R5F111PH, R5F111PJ 

RX 

110 R5F51101, R5F51103, R5F51104, R5F51105, R5F5110H, R5F5110J 

111 
R5F51111, R5F51113, R5F51114, R5F51115, R5F51116, R5F51117, 
R5F51118, R5F5111J 

113 R5F51135, R5F51136, R5F51137, R5F51138 
130 R5F51303, R5F51305, R5F51306, R5F51307, R5F51308 

210 
R5F52103, R5F52104, R5F52105, R5F52106, R5F52107, R5F52108, 
R5F5210A, R5F5210B 

21A R5F521A6, R5F521A7, R5F521A8 
220 R5F52201, R5F52203, R5F52205, R5F52206 
230 R5F52305, R5F52306 
231 R5F52315, R5F52316, R5F52317, R5F52318 
23T R5F523T3, R5F523T5 
24T R5F524T8, R5F524TA, R5F524TB, R5F524TC, R5F524TE 
24U R5F524UB, R5F524UC, R5F524UE 
610 R5F56104, R5F56106, R5F56107, R5F56108 
621 R5F56216, R5F56217, R5F56218 
62G R5F562G7, R5F562GA 
62N R5F562N7, R5F562N8 
62T R5F562T6, R5F562T7, R5F562TA 
630 R5F56307, R5F56308, R5F5630A, R5F5630B, R5F5630D, R5F5630E 
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631 

R5F56316, R5F56317, R5F56318, R5F5631A, R5F5631B, R5F5631D, 
R5F5631E, R5F5631F, R5F5631G, R5F5631J, R5F5631K, R5F5631M, 
R5F5631MF, R5F5631N, R5F5631P, R5F5631PF, R5F5631W, 
R5F5631Y, R5S56310 

634 
R5F5634B, R5F5634B_5V, R5F5634D, R5F5634D_5V, R5F5634E, 
R5F5634E_5V 

63N 
R5F563NA, R5F563NB, R5F563ND, R5F563NE, R5F563NF, 
R5F563NK, R5F563NW, R5F563NY 

63T 
R5F563T4, R5F563T5, R5F563T6, R5F563TB, R5F563TB_5V, 
R5F563TC, R5F563TC_5V, R5F563TE, R5F563TE_5V 

64M R5F564MF, R5F564MG, R5F564MJ, R5F564ML 

651 
R5F56514, R5F56517, R5F56519, R5F5651C, R5F5651C_DUAL, 
R5F5651E, R5F5651E_DUAL 

65N 
R5F565N4, R5F565N7, R5F565N9, R5F565NC, R5F565NC_DUAL, 
R5F565NE, R5F565NE_DUAL 

71M R5F571MF, R5F571MG, R5F571MJ, R5F571ML 

RZ 

A1 

R7S721000, R7S721000_DualSPI, R7S721001, R7S721001_DualSPI, 
R7S721010, R7S721010_DualSPI, R7S721011, R7S721011_DualSPI, 
R7S721020, R7S721020_DualSPI, R7S721021, R7S721021_DualSPI, 
R7S721030, R7S721030_DualSPI, R7S721031, R7S721031_DualSPI, 
R7S721034, R7S721034_DualSPI 

T1 

R7S910001, R7S910002, R7S910006, R7S910007, R7S910011, 
R7S910013, R7S910015, R7S910015_M3, R7S910016, 
R7S910016_M3, R7S910017, R7S910017_M3, R7S910018, 
R7S910018_M3, R7S910025, R7S910026, R7S910027, R7S910028, 
R7S910035, R7S910036, R7S910101, R7S910102, R7S910106, 
R7S910107, R7S910111, R7S910113, R7S910115, R7S910115_M3, 
R7S910116, R7S910116_M3, R7S910117, R7S910117_M3, 
R7S910118, R7S910118_M3, R7S910125, R7S910126, R7S910127, 
R7S910128, R7S910135, R7S910136 

Synergy *1 

S124 
R7FS124762A01CLM, R7FS124763A01CFL, R7FS124763A01CFM, 
R7FS124772A01CLM, R7FS124773A01CFL, R7FS124773A01CFM, 
R7FS124773A01CNB, R7FS124773A01CNE, R7FS124773A01CNF 

S128 R7FS128782A01CLM, R7FS128783A01CFJ, R7FS128783A01CFL, 
R7FS128783A01CFM, R7FS128783A01CNE, R7FS128783A01CNG 

S3A6 
R7FS3A6782A01CLJ, R7FS3A6783A01CFL, R7FS3A6783A01CFM, 
R7FS3A6783A01CFP, R7FS3A6783A01CNB, R7FS3A6783A01CNE, 
R7FS3A6783A01CNF 

S3A7 
R7FS3A77C2A01CLK, R7FS3A77C3A01CFB, R7FS3A77C2A01CBJ, 
R7FS3A77C3A01CFP, R7FS3A77C2A01CLJ, R7FS3A77C3A01CFM, 
R7FS3A77C3A01CNB 

S5D5 R7FS5D57A2A01CLK, R7FS5D57A3A01CFB, R7FS5D57A3A01CFP, 
R7FS5D57C2A01CLK, R7FS5D57C3A01CFB, R7FS5D57C3A01CFP 

S5D9 

R7FS5D97C2A01CBG, R7FS5D97C2A01CLK, R7FS5D97C3A01CFB, 
R7FS5D97C3A01CFC, R7FS5D97C3A01CFP, R7FS5D97E2A01CBG, 
R7FS5D97E2A01CLK, R7FS5D97E3A01CFB, R7FS5D97E3A01CFC, 
R7FS5D97E3A01CFP 

S7G2 

R7FS7G27G3A01CFP, R7FS7G27G3A01CFB, R7FS7G27H3A01CFB, 
R7FS7G27G2A01CLK, R7FS7G27H2A01CLK, R7FS7G27G2A01CBG, 
R7FS7G27H2A01CBG, R7FS7G27G3A01CFC, R7FS7G27H3A01CFC, 
R7FS7G27G2A01CBD, R7FS7G27H2A01CBD 
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Note: *1: The Synergy Software Package (SSP) can supply additional Synergy device support. Please check 
the release note for the SSP version you are using for additional device support. 

e2 studio 6.1.0 has not been qualified for use with Renesas Synergy. Please refer to the Synergy Gallery for 
the latest version of e2 studio approved for use with Renesas Synergy. 
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2.2 Code Generator Support 
 

CPU Family Devices 

RL78 

D1A 

R5F10CGB, R5F10CGC, R5F10CGD, R5F10CLD, R5F10CMD, R5F10CME, 
R5F10DGC, R5F10DGD, R5F10DGE, R5F10DLD, R5F10DLE, R5F10DMD, 
R5F10DME, R5F10DMF, R5F10DMG, R5F10DMJ, R5F10DPE, R5F10DPF, 
R5F10DPG, R5F10DPJ, R5F10TPJ 

F12 

R5F10968, R5F1096A, R5F1096B, R5F1096C, R5F1096D, R5F1096E, 
R5F109AA, R5F109AB, R5F109AC, R5F109AD, R5F109AE, R5F109BA, 
R5F109BB, R5F109BC, R5F109BD, R5F109BE, R5F109GA, R5F109GB, 
R5F109GC, R5F109GD, R5F109GE, R5F109LA, R5F109LB, R5F109LC, 
R5F109LD, R5F109LE 

F13 

R5F10A6A, R5F10A6C, R5F10A6D, R5F10A6E, R5F10AAA, R5F10AAC, 
R5F10AAD, R5F10AAE, R5F10ABA, R5F10ABC, R5F10ABD, R5F10ABE, 
R5F10AGA, R5F10AGC, R5F10AGD, R5F10AGE, R5F10AGF, R5F10AGG, 
R5F10ALC, R5F10ALD, R5F10ALE, R5F10ALF, R5F10ALG, R5F10AME, 
R5F10AMF, R5F10AMG, R5F10BAC, R5F10BAD, R5F10BAE, R5F10BAF, 
R5F10BAG, R5F10BBC, R5F10BBD, R5F10BBE, R5F10BBF, R5F10BBG, 
R5F10BGC, R5F10BGD, R5F10BGE, R5F10BGF, R5F10BGG, R5F10BLC, 
R5F10BLD, R5F10BLE, R5F10BLF, R5F10BLG, R5F10BME, R5F10BMF, 
R5F10BMG 

F14 

R5F10PAD, R5F10PAE, R5F10PBD, R5F10PBE, R5F10PGD, R5F10PGE, 
R5F10PGF, R5F10PGG, R5F10PGH, R5F10PGJ, R5F10PLE, R5F10PLF, 
R5F10PLG, R5F10PLH, R5F10PLJ, R5F10PME, R5F10PMF, R5F10PMG, 
R5F10PMH, R5F10PMJ, R5F10PPE, R5F10PPF, R5F10PPG, R5F10PPH, 
R5F10PPJ 

F15 
R5F113GK, R5F113GL, R5F113LK, R5F113LL, R5F113MK, R5F113ML, 
R5F113PG, R5F113PH, R5F113PJ, R5F113PK, R5F113PL, R5F113TG, 
R5F113TH, R5F113TJ, R5F113TK, R5F113TL 

G10 R5F10Y14, R5F10Y16, R5F10Y17, R5F10Y44, R5F10Y46, R5F10Y47 
G11 R5F1056A, R5F1057A, R5F1058A 

G12 

R5F10266, R5F10267, R5F10268, R5F10269, R5F1026A, R5F10277, 
R5F10278, R5F10279, R5F1027A, R5F102A7, R5F102A8, R5F102A9, 
R5F102AA, R5F10366, R5F10367, R5F10368, R5F10369, R5F1036A, 
R5F10377, R5F10378, R5F10379, R5F1037A, R5F103A7, R5F103A8, 
R5F103A9, R5F103AA 

G13 

R5F1006A, R5F1006C, R5F1006D, R5F1006E, R5F1007A, R5F1007C, 
R5F1007D, R5F1007E, R5F1008A, R5F1008C, R5F1008D, R5F1008E, 
R5F100AA, R5F100AC, R5F100AD, R5F100AE, R5F100AF, R5F100AG, 
R5F100BA, R5F100BC, R5F100BD, R5F100BE, R5F100BF, R5F100BG, 
R5F100CA, R5F100CC, R5F100CD, R5F100CE, R5F100CF, R5F100CG, 
R5F100EA, R5F100EC, R5F100ED, R5F100EE, R5F100EF, R5F100EG, 
R5F100EH, R5F100FA, R5F100FC, R5F100FD, R5F100FE, R5F100FF, 
R5F100FG, R5F100FH, R5F100FJ, R5F100FK, R5F100FL, R5F100GA, 
R5F100GC, R5F100GD, R5F100GE, R5F100GF, R5F100GG, R5F100GH, 
R5F100GJ, R5F100GK, R5F100GL, R5F100JC, R5F100JD, R5F100JE, R5F100JF, 
R5F100JG, R5F100JH, R5F100JJ, R5F100JK, R5F100JL, R5F100LC, R5F100LD, 
R5F100LE, R5F100LF, R5F100LG, R5F100LH, R5F100LJ, R5F100LK, R5F100LL, 
R5F100MF, R5F100MG, R5F100MH, R5F100MJ, R5F100MK, R5F100ML, 
R5F100PF, R5F100PG, R5F100PH, R5F100PJ, R5F100PK, R5F100PL, 
R5F100SH, R5F100SJ, R5F100SK, R5F100SL, R5F1016A, R5F1016C, 
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R5F1016D, R5F1016E, R5F1017A, R5F1017C, R5F1017D, R5F1017E, 
R5F1018A, R5F1018C, R5F1018D, R5F1018E, R5F101AA, R5F101AC, 
R5F101AD, R5F101AE, R5F101AF, R5F101AG, R5F101BA, R5F101BC, 
R5F101BD, R5F101BE, R5F101BF, R5F101BG, R5F101CA, R5F101CC, 
R5F101CD, R5F101CE, R5F101CF, R5F101CG, R5F101EA, R5F101EC, 
R5F101ED, R5F101EE, R5F101EF, R5F101EG, R5F101EH, R5F101FA, 
R5F101FC, R5F101FD, R5F101FE, R5F101FF, R5F101FG, R5F101FH, 
R5F101FJ, R5F101FK, R5F101FL, R5F101GA, R5F101GC, R5F101GD, 
R5F101GE, R5F101GF, R5F101GG, R5F101GH, R5F101GJ, R5F101GK, 
R5F101GL, R5F101JC, R5F101JD, R5F101JE, R5F101JF, R5F101JG, R5F101JH, 
R5F101JJ, R5F101JK, R5F101JL, R5F101LC, R5F101LD, R5F101LE, R5F101LF, 
R5F101LG, R5F101LH, R5F101LJ, R5F101LK, R5F101LL, R5F101MF, 
R5F101MG, R5F101MH, R5F101MJ, R5F101MK, R5F101ML, R5F101PF, 
R5F101PG, R5F101PH, R5F101PJ, R5F101PK, R5F101PL, R5F101SH, 
R5F101SJ, R5F101SK, R5F101SL 

G14 

R5F104AA, R5F104AC, R5F104AD, R5F104AE, R5F104AF, R5F104AG, 
R5F104BA, R5F104BC, R5F104BD, R5F104BE, R5F104BF, R5F104BG, 
R5F104CA, R5F104CC, R5F104CD, R5F104CE, R5F104CF, R5F104CG, 
R5F104EA, R5F104EC, R5F104ED, R5F104EE, R5F104EF, R5F104EG, 
R5F104EH, R5F104FA, R5F104FC, R5F104FD, R5F104FE, R5F104FF, 
R5F104FG, R5F104FH, R5F104FJ, R5F104GA, R5F104GC, R5F104GD, 
R5F104GE, R5F104GF, R5F104GG, R5F104GH, R5F104GJ, R5F104GK, 
R5F104GL, R5F104JC, R5F104JD, R5F104JE, R5F104JF, R5F104JG, R5F104JH, 
R5F104JJ, R5F104LC, R5F104LD, R5F104LE, R5F104LF, R5F104LG, R5F104LH, 
R5F104LJ, R5F104LK, R5F104LL, R5F104MF, R5F104MG, R5F104MH, 
R5F104MJ, R5F104MK, R5F104ML, R5F104PF, R5F104PG, R5F104PH, 
R5F104PJ, R5F104PK, R5F104PL 

G1A 
R5F10E8A, R5F10E8C, R5F10E8D, R5F10E8E, R5F10EBA, R5F10EBC, 
R5F10EBD, R5F10EBE, R5F10EGA, R5F10EGC, R5F10EGD, R5F10EGE, 
R5F10ELC, R5F10ELD, R5F10ELE 

G1C R5F10JBC, R5F10JGC, R5F10KBC, R5F10KGC 
G1D R5F11AGG, R5F11AGH, R5F11AGJ 
G1E R5F10FLC, R5F10FLD, R5F10FLE, R5F10FMC, R5F10FMD, R5F10FME 

G1F R5F11B7C, R5F11B7E, R5F11BBC, R5F11BBE, R5F11BCC, R5F11BCE, 
R5F11BGC, R5F11BGE, R5F11BLC, R5F11BLE 

G1G R5F11EA8, R5F11EAA, R5F11EB8, R5F11EBA, R5F11EF8, R5F11EFA 
G1H R5F11FLJ, R5F11FLK, R5F11FLL 
I1A R5F1076C, R5F107AC, R5F107AE, R5F107DE 
I1B R5F10MME, R5F10MMG, R5F10MPE, R5F10MPG 
I1C R5F10NLE, R5F10NLG, R5F10NME, R5F10NMG, R5F10NMJ, R5F10NPJ 

I1D R5F11768, R5F1176A, R5F11778, R5F1177A, R5F117A8, R5F117AA, 
R5F117AC, R5F117BA, R5F117BC, R5F117GA, R5F117GC 

I1E R5F11CBC, R5F11CCC 

L12 
R5F10RB8, R5F10RBA, R5F10RBC, R5F10RF8, R5F10RFA, R5F10RFC, 
R5F10RG8, R5F10RGA, R5F10RGC, R5F10RJ8, R5F10RJA, R5F10RJC, 
R5F10RLA, R5F10RLC 

L13 
R5F10WLA, R5F10WLC, R5F10WLD, R5F10WLE, R5F10WLF, R5F10WLG, 
R5F10WMA, R5F10WMC, R5F10WMD, R5F10WME, R5F10WMF, 
R5F10WMG 

L1A R5F11MMD, R5F11MME, R5F11MMF, R5F11MPE, R5F11MPF, R5F11MPG 
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L1C 

R5F110ME, R5F110MF, R5F110MG, R5F110MH, R5F110MJ, R5F110PE, 
R5F110PF, R5F110PG, R5F110PH, R5F110PJ, R5F111ME, R5F111MF, 
R5F111MG, R5F111MH, R5F111MJ, R5F111PE, R5F111PF, R5F111PG, 
R5F111PH, R5F111PJ 

RX 

110 R5F51101, R5F51103, R5F51104, R5F51105, R5F5110H, R5F5110J 

111 R5F51111, R5F51113, R5F51114, R5F51115, R5F51116, R5F51117, 
R5F51118, R5F5111J 

113 R5F51135, R5F51136, R5F51137, R5F51138 
130 R5F51303, R5F51305 
230 R5F52305, R5F52306 
231 R5F52315, R5F52316, R5F52317, R5F52318 
23T R5F523T3, R5F523T5 
24T R5F524T8, R5F524TA, R5F524TB, R5F524TC, R5F524TE 
24U R5F524UB, R5F524UC, R5F524UE 
64M R5F564MF, R5F564MG, R5F564MJ, R5F564ML 
651 R5F56514, R5F56517, R5F56519 
65N R5F565N4, R5F565N7, R5F565N9 
71M R5F571MF, R5F571MG, R5F571MJ, R5F571ML 

RZ T1 

R7S910001, R7S910002, R7S910006, R7S910007, R7S910011, R7S910013, 
R7S910015, R7S910016, R7S910017, R7S910018, R7S910025, R7S910026, 
R7S910027, R7S910028, R7S910035, R7S910036, R7S910101, R7S910102, 
R7S910106, R7S910107, R7S910111, R7S910113, R7S910115, R7S910116, 
R7S910117, R7S910118, R7S910125, R7S910126, R7S910127, R7S910128, 
R7S910135, R7S910136 
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3. Smart Manual Support 
Smart manual support is delivered independently of e² studio releases when available. The following devices are 
available as of the 27th of July, 2017. 

• RX62G 

• RX62T 

• RX63N 

• RX63T 

• RX64M 

• RX71M 

• RX110 

• RX111 

• RX113 

• RX210 

• RX220 

• RX631 

• RX651 

• RX65N 

• RX24U 

• RX24T 

• RL78/L12 

• RL78/L13 

• RL78/G14 

• RL78/G13 

• RL78/G12 

• RL78/G11 

• RL78/G10 

• RL78/G1F  
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4. What is new in 6.1.0? 
Component Device Description 

RZ/G 
Debugging 

RZ/G When installing the RZ/G feature the Trace Compass and Lttng plugins 
are now also installed. 

This will enable Linux OS trace support when debugging Linux target. 
RZ/G 

Toolchain 
integration 

RZ/G Linaro GCC version 5.2 is now supported for RZ/G. 

Stack 
Analysis 

All Support within the Stack Analysis plugin has been added for GCC 
toolchains. 

DS-5 
Converter 

RZ Support for the ARM DS-5 project converter has been added back into 
the product. It is available in the standard Import Eclipse system and 
can be accessed from “File->Import…” 

 

This importer will migrate the toolchain to the Launchpad GNU ARM 
toolchain. This can be downloaded from here. 

This feature can import from the following IDE/toolchain combinations: 

• ARM DS-5 project with a KPIT RZ GCC Toolchain. 
• ARM DS-5 project with a KPIT ARM-None GCC Toolchain. 

The project once converted may not build and operate perfectly for a 
list of known issues with the conversion please see the latest open 
issue list here: 

 

 

https://launchpad.net/gcc-arm-embedded
https://www2.renesas.eu/_custom/software/ree_eclipse/e2studio6/docs/releasenotes/6.1.0/openissues.htm
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CCRX to RX 
GCC Project 

Converter 

RX Support for the CCRX to GCC project converter has been added back 
into the product. It is available in the standard Import Eclipse system 
and can be accessed from “File->Import…” 
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There is no guarantee that the project once converted will build and 
operate perfectly. For a list of known issues with the conversion please 
see the latest open issue list here: 

 
MISRA-C 
Settings 

RX, RL The MISRA-C plugin settings have been moved from the workspace 
location to the project location. 

This enables the settings to be shared among users of the same 
project. 

Visual 
Expressions 

All The Visual Expressions plugin settings have been moved from the 
workspace location to the project location. 

This enables the settings to be shared among users of the same 
project. 

Memory 
Usage 

RZ The memory usage view has been enhanced to support GCC ARM 
Embedded toolchain. 

  

https://www2.renesas.eu/_custom/software/ree_eclipse/e2studio6/docs/releasenotes/6.1.0/openissues.htm
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5. What is new in 6.0.0? 
Note: This section is reserved for the new users migrated to 6.0/6.1 from 5.x or earlier versions of e2 studio. 

Component Device Description 
Project 

Generation 
All The project generation tools in 6.0 have been revised and the look and 

feel improved. 

The new generator is accessed via the C/C++ Project. 

 

The RZ/G project generator is accessed from the RZ/G C/C++ Project 
menu item in the same manner as 5.x. 

The Synergy project generators are accessed from Synergy C Project 
or Synergy C++ Project in the same manner as 5.x. 

When selecting the C/C++ Project wizard the following dialog is shown 
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Note the C Managed Build and C++ Managed Build types are default 
CDT projects. Please use the Renesas project types for the device you 
wish to use. There are separate entries for each device, toolchain and 
project type (Executable or Library) combination. 

The actual wizard to create the projects also has an updated look and 
feel. The functionality provided is very similar to 5.x. 

 

When the project is created all generated files are stored within the 
project in the “generate” folder. This is to make it clearer which files 
within the project were provided by the project generator. 
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Revised 
Builder 

components 

 The builder components within e2 studio 6.0 have been overhauled 
and updated to work well with the latest CDT. 

The affected toolchains are CCRX, CCRL, GCC RX and GCC RL. For 
information on migration of old projects please see the useful 
information and workarounds section. 

In addition the GCC ARM toolchain being used for RZ development 
has been migrated to now use the gnuarmeclipse open source plugins 
that are already in use for Synergy. 

The new settings dialog are available from the C/C++ Build, Settings 
page within the project properties. See below:  

 

The look and feel for each toolchain is similar to before but there are 
some considerations worth noting: 

1. The Toolchain tab 
• This tab controls the selected toolchain and version. 

The “Change toolchain version” functionality present 
previous e2 studio versions has been removed and 
replaced with this. 

• In addition extra tools such as “Objcpy” or “Libgen” can 
be enabled on this tab. When enabling the checkbox 
for the tools they will only then appear in the builder 
settings. 
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2. The Device tab 
• Previous versions of e2 studio had a special 

preference page for the currently selected device. This 
has been removed and an additional tab named 
“Device” has been added to the build settings. 

• Here it is possible to change the device, re-generate 
project generation files and update the build settings 
accordingly. 

 

3. Linker section changes 

• For CCRX and CCRL the linker sections are 
represented as a single string. The section editor 
is not shown on the settings page. To access the 
graphical section editor press the “…” button. 

• For all GCC tools there is no longer a graphical 
section editor integrated into the settings user 
interface for the GCC build plugins. 
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• Instead it uses the .ld linker script directly. A 
special graphical editor of .ld files has been 
integrated within the e2 studio. Simply double click 
the .ld file in the project and you can again edit the 
sections graphically. 

 

4. Renesas Quick Settings menu item 
• In previous versions of e2 studio there has been a 

menu named “Renesas Quick Settings”. 
• This menu item used to take you directly to the build 

settings for the selected project. 
• This functionality cannot be implemented in e2 studio 

6.0 so the menu item has been removed. 

Installer 
 

All The e2 studio product structure has been enhanced so that each 
device can be installed in its own independent way. 

Each device’s support is versioned independently from the main 6.0 
product. It means that updates to one device will not affect the other 
devices. 

The installer allows you to select this at installation time. 
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The above example shows a user only installing the Synergy device 
family. Subsequent updates of other device families will not affect this 
installation unless the main core of the product is also updated. 

To see the version of your installed device feature you can visit the 
About Box. 

 

Clicking on the device will give the installed versions of components for 
this device. e.g. In the example below RX was clicked: 
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This version information will be valuable if you need to discuss 
problems you encounter with Renesas technical support contacts. 

 
Updated user 

interface 
All Some changes have been made to the e2 studio 6.0 user interface to 

improve the usability of the user interface. 

The most major improvement is the introduction of the Launch Bar. 

 

This launch bar allows you to very clearly understand what will happen 
when the build and debug buttons are pressed. The selected project 
and debug configuration in the drop list will provide the context for the 
operation. 

In addition the debug toolbar buttons have been switched off from the 
debug view and added to the main debug toolbar. 

 
RZ Semi 
hosting 

RZ When using the RZ debugger in previous e2 studio semi hosting was 
supported but did not fully support the SYS mode. This mode of 
operation is now supported in the e2 studio 6.0 RZ debugger when 
using the Segger J-link emulator. 
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Smart 
Browser 

 

All The Smart Browser has been enhanced to show when updates are 
available for items shown within the user interface. 

 

When items such as updates to documents or new tool news 
information are available a notification bubble will be displayed 
informing you that new items are available. 

 

 
RTOS 

Graphical 
Stack Usage 

 

Synergy Stack usage is now shown in a graphical way when using the Partner 
OS plugin and ThreadX. 

 

 
XML 

Comparison 
Synergy 
and RX, 

RZ 

e2 studio now has a XML file comparison tool built into the UI. This can 
be used for the configuration.xml files in the Synergy editor and the 
Smart Configurator. 

Right click on the file in the project tree that needs comparison and 
select “Compare With->Local History…” 
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The following dialog is then displayed: 

 

These are the list of revisions of the file that was selected in the project 
tree. Double clicking an instance of the file will then compare with the 
current version on disk. A difference window is shown showing the 
differences: 
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Help System 

 
All The help system in previous versions of e2 studio was not well 

organised which meant finding topics was not easy. 

In e2 studio 6.0 the help has been re-structured to make it easier to 
find what you are looking for. See below: 

 

 
Smart 

Configurator 
RX, RZ The main feature improvements for Smart Configurator in e2 studio 6.0 

include: 

• Code Generator driver support for RX64M [37 components] 
• CG driver support for RX65N/1 (+2MB devices) [37 

components] 



e² studio 6.1.0 Release Note 

R20UT4191EE0100  Rev.1.00  Page 26 of 38 
October 16th, 2017  

• CG driver support for RX130  (+512KB devices) [35 
components] 

E2 Emulator RL78 E2 emulator support has been added to e2 studio 6.0. This emulator 
offers all the same functions as the E1 emulator. 

It also offers: 

• Consumption current measurement support. 
• External trigger support. 

The Consumption current measurement shows graphically the 
current drawn by the board. 

It allows monitor points to be set which are shown on this view as 
markers. This allows you to tie the source code to specific power 
consumption. 

 

 
Application All e2 studio has many debug views and not all are supported for all 

device families. 

This can cause confusion so a new feature has been added to close 
debug views that are not supported by the current debug session. 

This is available from the Window menu under the Perspective menu. 
Selecting the device will close all windows not supported by that 
device.  

Note this menu item is only available in the debug perspective. 
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Enhanced 
Threads 

Page 

Synergy The Synergy threads page has had the following enhancements made 
to it: 

• Keyboard navigation within the module stack viewer 
• Renaming threads will refactor code accordingly 
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6. Useful workarounds and information for 6.1.0 
Please visit the Renesas FAQ for e² studio for the latest up to date information: 

Online FAQ link. 

ID Component Workaround or information 
 Application This version of e² studio is based on Eclipse Neon.1 and CDT 9.2.1.  This 

release note does not describe the Eclipse framework and CDT plugin issues 
and fixes. You can find the detailed information on the sites below: 
 
For information on the Neon release see here: 
https://projects.eclipse.org/releases/neon 
 
CDT: 
Has been significantly improved and this version contains a major version up 
over 5.4: 
Please see New and Noteworthy for CDT here: 
 
https://wiki.eclipse.org/CDT/User/NewIn90 
https://wiki.eclipse.org/CDT/User/NewIn91 
https://wiki.eclipse.org/CDT/User/NewIn92 
 
The Eclipse bug tracker is here: 
https://bugs.eclipse.org/bugs/ 
 

 SH support The Renesas SH device family is no longer supported in e2 studio. 
 
If you need to use the SH device support please use e2 studio 5.4 or earlier. 
 

 Importing old 
projects into 
6.x 

All projects being migrated into e2 studio 6.0 from previous e2 studio versions 
will need to be migrated to the new builder plugins. The new builder plugins have 
different user interface pages and different option IDs. 
 
Upon opening an older workspace the following dialog would be displayed: 
 

 
 
Clicking OK will update the workspace to e2 studio 6.0. 
 
Importing an existing project to the workspace or opening a workspace with old 
projects will automatically start the legacy project upgrade procedure.  
 
If for some reason this process does not start it is also possible to launch the 
“Upgrade Legacy of e2 studio Projects…” from the project context menu. 
 

https://en-eu.knowledgebase.renesas.com/Special:Search?q=e2%20studio&path=&limit=55&page=2&tags=
https://projects.eclipse.org/releases/neon
https://wiki.eclipse.org/CDT/User/NewIn90
https://wiki.eclipse.org/CDT/User/NewIn91
https://wiki.eclipse.org/CDT/User/NewIn92
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The automatic system pops up a message bubble in the bottom left of the e2 
studio application window. 
 

 
 
After selecting the menu item or clicking the bubble the following dialog will be 
shown: 
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To upgrade the project, click the corresponding check box and then click Finish. 
Note, this will update the project to the latest build plugins and options. Before 
doing this you should ensure your project is backed up as this operation is not 
reversible. 
 
It is possible to upgrade multiple projects in a single operation. 
 
For the GCC toolchains for RX and RL changes have been made to the build 
options which mean we cannot guarantee the same binary output after upgrade. 
Please consider this before upgrading to 6.0. 
 
For the GNUARM-NONE toolchain projects, they can be converted to 6.0 project 
but options and configuration might not be migrated exactly the same as original 
project. Please consider using 5.x in the meantime if you have any difficulty in 
migrating to 6.0, or create a new project on 6.0 environment.  
 
Another consideration for migration is that debug configurations when opened in 
6.0 will also need to be migrated. The following message will be displayed. 
 

 
 
Please ensure that your projects are backed up or in revision control before 
migration allowing you to return to older versions if required. 
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Toolchain 
Management 
 

Before e2 studio 6.0 the toolchain management facility automatically upgraded 
or downgraded the imported project to the latest tools installed on the host 
machine. 
 
This no longer happens in e2 studio 6.0. Instead the toolchain remains the same 
and user operation is the only way to change the toolchain version. 
 
This operation is now available within the build settings on the toolchain tab. An 
example of CCRX is shown below: 
 

 
 
If the particular toolchain version does not exist and build is performed then an 
error message is displayed and the build will fail. 
 

 RZ Toolchain The now legacy KPIT GNU ARM-NONE toolchain is still supported within the e2 
studio product but now using the gnuarmeclipse plugins. 
 
In addition RZ within e2 studio now supports the GNU ARM Launchpad 
toolchain. Available from https://launchpad.net/gcc-arm-embedded. 
 
One drawback of this toolchain is that it does not have a standard library builder 
provided in the same manner as the legacy KPIT ARM-NONE toolchain. To use 
this feature for ARM Launchpad and gain access to the more efficient optlib 
libraries a further download is required. 
 
This can be downloaded within the e2 studio installer or directly from here: 
https://gcc-renesas.com/rz/rz-download-toolchains/ 
 
Once integrated it is possible to integrate the library generator from the toolchain 
tab of the build settings page. 
 

https://launchpad.net/gcc-arm-embedded
https://gcc-renesas.com/rz/rz-download-toolchains/
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See “Create Library generator” option. Once checked the library generator 
(libgen) is added to the available tool settings. 
 

 QE 
compatibility 

If QE for TCP/IP V1.0.0 is used, please update it to V1.0.1. 
Other QE series can be used with e2 studio 6.0. 
 
What is QE? 
https://www.renesas.com/products/software-tools/tools/solution-toolkit/qe.html 
 
Details of QE for TCP/IP 
https://www.renesas.com/products/software-tools/tools/solution-toolkit/qe-qe-for-
tcp-ip.html  
 

5954 Application If you experience the error message “org.eclipse.swt.SWTError: No more 
handles” this can be caused by certain multi-monitor software and the Eclipse 
framework. 
 
If this error occurs there are 2 workarounds: 
 

1. Use a single monitor display. 
2. Uninstall the multiple monitor software from your graphics chipset 

vendor and revert to the standard Windows multi-monitor feature. 
 

6981 RL78 
Debugging 

When debugging IAR C source file with an OCD emulator (E1), the Monitor 
program area (0x00002-0x00003) is used. 
 
So this area must be excluded from usable address space. Please add '-HFF' in 
the linker option. 
 
- Open Property. 
 
- Select [C/C++ build]-[Settings] at left side. 
 
- Select 'IAR RL78 Xlink linker' at right side, add '-HFF' at the textbox 'command'. 
 
Not doing this will cause problems with connection and download when using 
interrupts. 
 

NA Application If you are experiencing slow building of projects within e² studio there are some 
possibilities to improve. 

https://www.renesas.com/products/software-tools/tools/solution-toolkit/qe.html
https://www.renesas.com/products/software-tools/tools/solution-toolkit/qe-qe-for-tcp-ip.html
https://www.renesas.com/products/software-tools/tools/solution-toolkit/qe-qe-for-tcp-ip.html
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The system environment will attempt to find the make.exe tool via the system 
environment.  If you ensure the directory make resides in is at the start of the 
path variable it will find it more quickly.  Especially important if there are network 
drives in the path. 
 
In the project properties, C/C++ Build tab, behavior tab you can switch on 
parallel build.  This will take advantage of the multi-cores on your host machine if 
it has them. 
 

NA RZ GCC In 3.0 the KPIT GCC RZ toolchain was supported at version 14.01.  This version 
is no longer supported within e² studio. 
 
KPIT modified the name of their ARM toolchain to be ARM-none-eabi to follow 
standard ARM naming convention like other GCC toolchain vendors. 
 
The ARM-none toolchain is available at versions 14.01, 14.02 and 16.01 from 
the www.gcc-renesas.com website.  The binaries in the 14.01 version are 
identical to those used in the 14.01 RZ toolchain. 
 
Once the toolchain is installed your projects will be imported and ported to 
ensure there is as little disruption as possible due to this change. 
 

NA KPIT GCC The KPIT toolchains are now no longer supported by the www.kpitgnutools.com 
website. Support is now available from the www.gcc-renesas.com website. 
 
In addition, there are two new releases for the GNU toolchains for RX and RL78. 
These are now named Renesas GCC for RX and Renesas GCC for RL78. 
 
Both integrate into e² studio and can be selected from the project wizard. 
 

2010 HEW 
Importer 

Symptoms: Project fails to build after importing a legacy project from HEW 
 
Conditions: If a long filename or path is used, and the HEW project importer is 
used, the project may fail to build. 
 
Workaround: Move the original HEW project to a shallow directory structure (i.e.) 
C:\Workspace and import from there.  Also, ensure that the HEW project is 
relocated before importing into e² studio. 
 

1922 Application Symptoms: Project fails to build in first instance after archive project import (not 
from HEW) 
 
Conditions: If an archived project is imported, it may fail to build the first time, 
due to a residual .d file. 
 
Workaround: Clean and Build a second time. 
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2762 CODAN When using assembly code within a C source file, CODAN errors can be 
observed in the editor. Even though the project builds successfully, or even after 
rebuild index. 
 
Indexer buffer can be insufficient to process whole project. 
Please try giving larger values for the following configurations. 
 
Open preferences dialog through “Window”->”Preferences” menu. In “C/C++” -> 
“Indexer” tree, you will indexer configuration as shown below: 

 
 
Put larger values for each red-framed variables, then rebuild project or rebuild 
index.  

2728 GDB Step into does not always work when using the CC-RX 1.02.01 toolchain. 
 
To ensure this behaves correctly you will need to use CC-RX 2.00.00 or greater 
as this issue with the debug information is corrected in this release. 
 

NA Eventpoints If eventpoints do not always work just after they are set, you can use the "Apply 
to Target" toolbar button in the Eventpoint view to send the Eventpoints to the 
target manually.  This will always ensure the debugger target has all the required 
eventpoint updates before execution starts. 
 

5772 IAR Plugins The IAR Plugin Manager is included in e² studio and provides support for RX, 
RL78, RH850 and RZ (ARM). 
 
This tool, simplifies installation and configuration of IAR toolchain plugins. You 
can access this though Help -> IAR Embedded Workbench plugin manager. 
 

5903 Code 
Generator 

For the following RL78 code generator project, "Peripheral Functions" view tabs 
may not be operated with double-clicking "Peripheral Functions" branch of 
Project Explorer view. 
 
After creating/loading the project, please show "Code Preview" view by double-
clicking of "Code preview" branch at Project Explorer tree at first. Then, please 
access Code Generator setting tabs by double-clicking Project Explorer tree or 
using pull-down menu by pressing triangle button at the up-right corner of 
Peripheral Functions view. 
 
RL78/G12, RL78/G13, RL78/G14, RL78/G1A, RL78/I1A, RL78/F13, RL78/F14, 
RL78/F12, RL78/L12 
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6184 RL78/CC-RL 
debugging 

When the load module for RL78/G10 which created at CC-RL is debugged in E1, 
please specify the following option: 

[Linker] -> [Device] -> "Set enable/disable on-chip debug by link option 

7217 Application The restore default settings does not restore all of the options set during project 
generation.  Instead, it sets the defaults to the base settings for the device family 
in use. 

7524 RZ/T1 
Debugging 

In a RZ/T1 RAM-based project, the "Reload" function does not work. 

Reloading or re-downloading during debugging resets the device and the RAM 
content is erased. 

To continue the debugging, disconnect and connect the debugger again. 

 Use spaces 
as tabs 

Eclipse and CDT both have settings for use spaces as tabs. The option on the 
Editor preferences page conflicts with the CDT formatter settings. 

To change the use spaces as tabs option in e² studio please use this page: 

 
 Installer 

problems 
In some situations, the AVG virus checker appears to interfere with the e² studio 
installation process. If you experience such a problem, please temporarily 
disable the AVG tool and try the installation again. 

 Antivirus In some situations, the Norton anti-virus tool can interfere with the building of 
Renesas Synergy projects. If possible, please disable the antivirus program 
when building Renesas Synergy projects on systems with Norton Antivirus 
installed. 

 Green Hills 
RH850 
Projects 

When debugging the RH850 object built with the Green Hills compiler in e2 
studio, specify the following option for the compiler option. 

 -gtws 

The GUI setting menu is as follows. 

[GHS C Compiler for V800 Standalone]-[Debugging Option] 

     "Generate Target-Walkable Stack" -> On 

If this option is not specified, Step Over and Step Return may not work properly. 

17052 Debugging When debugging using a project with duplicate filenames that are located in 
different source folders problems can be seen with breakpoint setting. 

When a breakpoint is set at a source line in this file it will also stop at the same 
source line in the other same named file when execution passes through. 
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7. Open Issues in 6.1.0 
 
Open issues in the e2 studio 6.1 product will be kept up to date here: 
 
Please visit to see the latest open issue list. 
  

https://www2.renesas.eu/_custom/software/ree_eclipse/e2studio6/docs/releasenotes/6.1.0/openissues.htm
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8. Appendix 
8.1 Website and Support  
Renesas Electronics Website 

http://www.renesas.com/ 
 
Inquiries 

http://www.renesas.com/contact/ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.renesas.com/
http://www.renesas.com/contact/
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